Getting Started with Digitizer
EXTENDED EDITION

NOTICE
This document and the Sage Timberline Office software may be used only in accordance with the accompanying Sage Timberline End User License Agreement. You may not use, copy, modify, or transfer the Sage Timberline Office software or this documentation except as expressly provided in the license agreement.

Visit our Web site at www.sagetimberlineoffice.com or call 1-800-330-7163 to learn about training classes that are added throughout the year.

©2005 Sage Software. All rights reserved. The Sage Software logo and the Sage Software product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc., or its affiliated entities. All other trademarks or registered trademarks are the property of their respective holders.
## Contents

**Welcome to Timberline Digitizer**  
- How to use this booklet ........................................... 1  
- Help - always at your fingertips ................................. 2  
  - Comprehensive help on your computer ......................... 2  
  - Technical support .................................................. 3  
- First things first ..................................................... 4  
  - Check your product package .................................... 4  
  - Install the software .............................................. 4  
  - How to start Timberline Digitizer ............................. 4

**Some basic concepts**  
- How to work with a digitizing device .......................... 6  
  - The Digitizer window ............................................ 6  
  - What you see in the graphics area ............................ 7  
  - How to deal with a large drawing ............................. 7  
- How Digitizer works with Estimating .......................... 8  
  - Using Digitizer .................................................... 8
### The ABCs of digitizing

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Help system</td>
<td>12</td>
</tr>
<tr>
<td>Locating the tablet menu</td>
<td>14</td>
</tr>
<tr>
<td>Selecting part of the plan to work on</td>
<td>16</td>
</tr>
<tr>
<td>Setting the drawing scale</td>
<td>18</td>
</tr>
<tr>
<td>Counting</td>
<td>20</td>
</tr>
<tr>
<td>Digitizing single lines</td>
<td>22</td>
</tr>
<tr>
<td>Digitizing continuous lines</td>
<td>24</td>
</tr>
<tr>
<td>Digitizing areas</td>
<td>26</td>
</tr>
<tr>
<td>Saving digitized results</td>
<td>28</td>
</tr>
<tr>
<td>Printing the image</td>
<td>30</td>
</tr>
</tbody>
</table>

### Time-saving tips

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Making the most of Digitizer</td>
<td>34</td>
</tr>
<tr>
<td>Shortcut menus</td>
<td>34</td>
</tr>
<tr>
<td>Status bar</td>
<td>34</td>
</tr>
<tr>
<td>Totals bar</td>
<td>34</td>
</tr>
<tr>
<td>Placing the toolbar conveniently</td>
<td>35</td>
</tr>
<tr>
<td>Saving an image</td>
<td>35</td>
</tr>
<tr>
<td>What to do if you make a mistake</td>
<td>36</td>
</tr>
<tr>
<td>Digitizing from Estimating</td>
<td>37</td>
</tr>
<tr>
<td>Setting the digitizing mode in advance</td>
<td>37</td>
</tr>
<tr>
<td>Using the dimension list</td>
<td>38</td>
</tr>
<tr>
<td>Importing digitized dimensions</td>
<td>39</td>
</tr>
<tr>
<td>Saving digitized images for assemblies</td>
<td>40</td>
</tr>
</tbody>
</table>

### Go ahead ... try it out

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>And in conclusion</td>
<td>41</td>
</tr>
</tbody>
</table>
Welcome to Timberline Digitizer

Timberline® Digitizer Extended from Timberline Software is intended to bring a full range of digitizer functionality to users of Estimating. As soon as you are familiar with the information in this booklet, you should be ready to begin using Digitizer.

How to use this booklet

We know you are eager to start working as quickly as possible, and the goal of this booklet is to help you do just that. Depending on your level of experience, you may find the following sections of interest.

- **Some basic concepts** — the concepts and philosophy behind Digitizer
- **The ABCs of digitizing** — step-by-step instructions for the most commonly performed procedures
- The discussion about using our extensive Help system should be of particular interest to all users.
- **Time-saving tips** — helpful hints for using Digitizer
- **Go ahead ... try it out** — a last word of advice
Help - always at your fingertips

Digitizer provides all the help you need right on your computer. In addition, our competent technical staff is ready to assist you.

- The software includes a comprehensive Help system. It provides not only context-sensitive help about what you are doing, but also step-by-step instructions and “Show Me” demos.
- If you purchased the software, you automatically receive 90 days of free telephone support and other benefits.
- You can also obtain information from our web page (www.timberline.com) on the Internet.

Comprehensive help on your computer

Instead of bulky manuals that you never quite get around to reading, help files come with Digitizer. Our efficient Help system provides faster access to more information than most manuals. With a click of the mouse or a keystroke, you can easily get help for a command, a field, a window, or a procedure.

Field level help

Window level help

Help Topics
- What's This?
- Show Me Demos
- Using Help
- License Agreements
- Timberline Services...
- Timberline on the Web
- About PLWin...

Field level help
- Topic level help
- Context-sensitive help
- Video demonstrations
- Instructions for using Help
- Timberline licences
- Telephone and e-mail support
- Web site for Timberline Software
- Software version information
Technical support

If you have questions or problems not covered by the Help system, you can communicate by telephone, FAX, or e-mail. The US support line is open from 7:00 a.m. to 5:00 p.m. Pacific time, Monday through Friday. Outside the US, contact your nearest distributor.

<table>
<thead>
<tr>
<th>For support in</th>
<th>Call</th>
<th>FAX</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>US/Canada</td>
<td>1-800-551-8307</td>
<td>503-439-5940</td>
<td><a href="mailto:pesupport@timberline.com">pesupport@timberline.com</a></td>
</tr>
<tr>
<td>Australia</td>
<td>1800 120 369</td>
<td>1503 439 5940</td>
<td><a href="mailto:aestrest@timberline.com">aestrest@timberline.com</a></td>
</tr>
<tr>
<td></td>
<td>+503 439 5178</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asia-Pacific</td>
<td>+503 439 5178</td>
<td>+503 439 5940</td>
<td><a href="mailto:aestrest@timberline.com">aestrest@timberline.com</a></td>
</tr>
<tr>
<td>Other international areas</td>
<td>+503 533 2181</td>
<td>+503 439 5940</td>
<td><a href="mailto:pesupport@timberline.com">pesupport@timberline.com</a></td>
</tr>
</tbody>
</table>

When calling, have your customer number handy and be at your computer.

- If you are not on a service plan, you can call on a charge-per-call basis. Please be prepared to give the number of a major credit card when you call.
- If you are using the trial software, please contact your local Solution Provider (authorized Timberline dealer).
First things first

The first thing you need to do is to set up the Timberline Estimating products on your computer. Timberline has automated the installation procedure, so the entire process takes only a few minutes.

Check your product package

The product package includes everything you need to install and use Digitizer. In addition to this booklet, you will find the following:

- The Timberline Estimating CD-ROM, which includes the Digitizer software. Your Digitizer access code installs Digitizer and the help files that give step-by-step instructions for using the software.
- A packing slip (with activation codes for each Timberline application).
- An installation card for basic instructions on installing the Estimating products.

Install the software

For information about installing the Estimating products, refer to the installation card included in the product package. You can find more detailed installation instructions, as well as tips for setting up Timberline Estimating, in the Resource and Installation Guide located on the CD-ROM in the Documents folder.

How to start Timberline Digitizer

After installing the software, you can open any Timberline application from the Start menu.

1. If you did not restart your computer at the end of the installation, do so now.
2. From the Start menu, open the Program group and then the Timberline Office group.
3. From the Estimating group, choose Digitizer.

Note: The typical method of starting Digitizer is directly from Timberline Estimating.
If you are new to Digitizer, there are a few basic concepts you should understand before you begin using the product. The concepts are not difficult, and you may already be familiar with some of them. After reading this section, you will be ready to try the procedures in *The ABCs of digitizing*.
How to work with a digitizing device

Digitizing involves using a pointing device (stylus or puck) to transfer the dimensions, lines, and shapes on the digitizer tablet to your computer. The lines and points you digitize appear in the graphics area of the Digitizer window.

Among the things you can control in the digitizer window are:

- size and position
- toolbar position and shape
- background color
- kind of units
- number of decimals shown
- line color and style
- count symbol
- display of coordinates

After you attach a digitizer and install the driver, you can use the pointing device as your mouse.

The Digitizer window

The graphics area, which corresponds to the digitizer tablet, occupies most of the main window. The menus, toolbar, and status information are located above and below the graphics area.
What you see in the graphics area

Whenever you start Digitizer, the screen is set up to encompass as much of the digitizer tablet as possible. There is a direct correspondence between the top and bottom of the digitizer tablet and the top and bottom of the active area on the screen. You can easily resize and reposition the screen to include a work area anywhere on the digitizer tablet.

How to deal with a large drawing

If you are working with large plans, it is more efficient to focus on one part of the drawing at a time. You simply define a work area on the drawing tablet by using the Zoom Window command in Digitizer. Defining a work area accomplishes two things:

- It enlarges the digitized image on your screen.
- It keeps the Digitizer menus within easy reach.

See page 16 for more about how to focus on a portion of the digitizer tablet.
How Digitizer works with Estimating

Digitizer is available from takeoff quantity cells and variable fields in Estimating. You can access the digitizer directly from the Estimating spreadsheet or from windows used to enter variables.

As a productivity tool, Digitizer lets you:

- make measurements on blueprints and transfer the measurements directly into Estimating
- set the drawing scale used for calculating dimensions

Once you choose a digitizing mode, you may notice that the mouse and pointing device move the cursor at different speeds.

In Estimating, the estimate is represented by a spreadsheet that contains items brought in from the database. Digitizer can be used to measure and calculate the takeoff quantities for the items in the estimate.

Using Digitizer

As you digitize or trace shapes on the blueprint, Digitizer draws the image, measures the shape in the scale you’ve set up, and displays the result on your screen. This is particularly useful for obtaining the dimensions of formula variables during takeoff. And if the variable has a preset digitizer mode (see page 37), Digitizer automatically starts in that mode (Area, Single Line, Continuous Line, or Count).

Right-click a variable field to open a shortcut menu with the Digitizer command.

Click here to start the Digitizer.
You can send a single total to Estimating right away or accumulate several measurements and send them as a single dimension. Another option is to name and save a series of digitized values that you can recall later from Estimating.
Now that you understand the basics of Digitizer, you are ready to start digitizing. This section includes an overview of the steps required to complete some of the tasks you perform most often.

- Using the Help system
- Locating the tablet menu
- Selecting part of the plan to work on (Zoom Window command)
- Setting the drawing scale
- Counting
- Digitizing single lines
- Digitizing continuous lines
- Digitizing areas
- Saving digitized results
- Printing the image
Using the Help system

No matter where you are in Digitizer, there is help available. How you get to the information is entirely up to you. One way is to go directly to the appropriate help topic from a field or window. Another way is to look for topics using the Contents, Index, and Find tabs in the Help window.

Keep in mind that the Help system contains all of the information in this book and much more. Step-by-step help topics and “Show Me” demos are available to guide you through many of the procedures covered in this section.

Get help about a field or window

You can get information about the commands, buttons, fields, options, or windows in Digitizer with a single keystroke or click of the mouse.

For information about a field or option, click here, then click the field.

For information about the window, click here.
Learn how to complete tasks with procedural topics

The Help system also includes step-by-step instructions for most tasks and procedures. It is always a good idea to check the "Related topics" at the bottom of a help topic for jumps to these procedural topics.

Find information

In the Help system, you can find information by looking in the table of contents and index and searching for specific words.

If you can't find what you need in the Contents or Index, you can search for any word or combination of words.
Locating the tablet menu

The tablet menu gives access to most of the features on the menus and toolbar in Digitizer. Using the tablet menu is optional, but it can eliminate the need to move back and forth between the digitizer and the keyboard.

The Locate Tablet Menu function tells Digitizer where the tablet menu is located on the digitizer, thus performing the necessary setup for the tablet menu to work.

This option is available only if:
- Your digitizer is hooked up.
- You’ve checked the Enable tablet menu box in the Options window.
- Digitizer can find the PDWmenu.dat file.

Position the tablet menu

Place the tablet menu within the active area on your digitizer. We recommend you tape the edges to securely fasten the tablet menu to the digitizer.

Choose the Locate Tablet Menu command

You can find this command on the Tools menu.
Digitize the points on the tablet menu

When you select the Locate Tablet Menu command, your cursor changes to a crossbar and the first prompt displays in the status bar.

1. Digitize this point first.

2. Digitize this point second.
Selecting part of the plan to work on

Before you begin doing takeoff with the Digitizer, you might want to select part of the plan to focus on. You can use the Zoom Window command to identify the portion of the plan where you want to work. “Zooming in” on the plan makes it easier to:

- Digitize large drawings.
- See details of the digitized image in the graphics area.

Choose the Zoom Window command

You can find this command on the View menu and the toolbar.

Choose the Zoom Window command

Digitize the upper left corner

Digitize the upper left corner of the area where you want to work and drag your pointing device (mouse, stylus, or digitizer puck) down and to the right.

A zoom rectangle appears to help you define the boundaries of the section where you want to work.
Digitize the lower right corner

When you reach the lower right corner of the section you want to work on, click again.

After you finish digitizing one part of a large drawing, click here to select another area ...

... or click here to reset the graphic area to include the entire digitizer tablet.
Setting the drawing scale

There are two ways to set the drawing scale:

- **Known scale** – use this procedure when the scale is provided for you and you are confident that it’s correct.
- **Autoscale** – use this procedure if the drawing is not to scale or the scale is not provided for you.

You can see the current drawing scale in the right corner of the Status bar.

### Open the Scale window

You can find the Scales command on the Digitize menu, the toolbar, and the status bar.

![Open the Scale window](image)

### Enter a known scale

If you know the drawing scale and are confident it is correct, enter the horizontal and vertical scales in the Scale window.

![Enter a known scale](image)
Use automatic scaling

If you aren't sure of the drawing scale, you can have Digitizer calculate the scale for you. To set the scale using a given line, you simply click the Autoscale button and digitize that line.

Click here.

Click the appropriate option to indicate whether the horizontal and vertical scales are the same or different.

Press the Esc key to cancel at any time.

Click OK to have Digitizer calculate the scale automatically.
Counting

Count mode tells you how many points have been entered with the digitizer. In addition, you have the ability to:

- Choose the count symbol that appears on the screen either before you start or while you are counting.
- See the previous and current dimensions by clicking the totals bar.
- Set up a count scale which is used as a multiplier for each point you digitize.

Start Count mode

You can find the Count command on the Digitize menu and the toolbar.

Digitize the points

As you digitize, the number of points displays in the totals bar. The current total can be added to or subtracted from the grand total. The Undo button allows you to remove count points one at a time.
Send the value to Estimating

You can add several counts and send them as a single total. When you finish counting, click the Done button to send the total to the selected field or cell in Estimating. Or you can save the count with a name and recall that value later in Estimating.
Digitizing single lines

Single Line mode calculates the straight-line distance between two digitized points. For example, you might use this mode to measure joist or rafter lengths. At any time you can:

■ Define the line style and color that appears on your screen.
■ See the last and current dimensions by clicking the totals bar.

As mentioned before, the toolbar includes buttons that allow you to add or subtract the current total to the grand total. The Undo button removes the last line digitized.

Start the Single Line mode

You can find the Single Line command on the Digitize menu and the toolbar.

Digitize the beginning and end of the line

For each line, digitize the two ends. Digitizer calculates the length which then appears as the current total in the totals bar. Digitizing a third point starts a new line and adds the current total to the grand total.
Send the value to Estimating

When you finish digitizing single lines, click Done to send the total to Estimating. Or you can save the dimension with a name and recall that value later in Estimating.
Digitizing continuous lines

Continuous Line mode calculates the length of a continuous line. For example, you might use this mode to measure the perimeter of a regular or irregular-shaped slab.

Again, you can:
- Define the line style and color.
- See the last and current dimensions.
- Add or subtract the current total to the grand total.
- Undo the entire line a point at a time.

Start the Continuous Line mode

You can find the Continuous Line command on the Digitize menu and the toolbar.

Digitize continuous lines

To measure a straight line, you simply digitize its endpoints. If the line is curved, press down on the pointing device as you trace. Digitizer shows the cumulative length in the totals bar as you move along the line.
**Send the value to Estimating**

When you finish digitizing continuous lines, click Done to send the total to Estimating. Or you can save the dimension with a name and recall that value later in Estimating.
Digitizing areas

Area mode calculates the area of a closed shape. For example, you might use this mode to measure the surface area and perimeter of a regular or irregular-shaped slab.

As in the other modes, you can:
- Define the line style and color.
- See the last and current dimensions.
- Add or subtract the current total to the grand total.
- Undo the last point digitized.

When you digitize areas, Digitizer also calculates the perimeter. You can transfer the value of that perimeter to an estimate using the Recall Perimeter command in Estimating.

Start the Area mode

You can find the Area command on the Digitize menu and the toolbar.

Digitize areas

Digitizing an area involves tracing or digitizing the outline of a shape much like the Continuous Line mode. But in Area mode, Digitizer automatically closes the shape by connecting the last point digitized to the first point while continuously calculating the enclosed area. When the shape is complete, click the Add or Done button.
If you want to exclude part of an area from the total, simply digitize the second area and use the Subtract button.

**Send the value to Estimating**

When you finish digitizing areas, click Done to send the total to Estimating. Or you can save the result with a name and recall that value later in Estimating.
Saving digitized results

Digitizer lets you digitize dimensions for an estimate in advance and save them to use later in Estimating. The workflow goes like this:

1. Use Digitizer to digitize and save all dimensions from your plans (steps A and B).

2. In Estimating, edit the saved dimensions as necessary (see page 38).

3. Recall a saved dimension to fill a takeoff quantity or variable field in the estimate (step C).

As an added convenience, you can save the image for each dimension.

The ability to save dimensions is available only when you start Digitizer from Estimating.

Digitize a dimension

You can save dimensions digitized with the Count, Single Line, Continuous Line, and Area modes.

Start by digitizing a dimension in the usual manner ...

and clicking Add to mark the end of the dimension.

Save the result

Choose Save Dimension on the File menu and enter a unique name and unit. When you save a digitized dimension, you are actually adding it to the dimensions list for the estimate from which you started the Digitizer.

To save using a dimension name from the estimate, click here.

To save the image, click here.

To save a perimeter, click here and enter its name and unit.
Recall the dimensions in Estimating

Back in Estimating, you can recall a saved dimension directly into a takeoff quantity cell in the estimate spreadsheet or a variable field during takeoff. For cells in the spreadsheet, Estimating rounds the dimension to the number of decimal places specified for that cell.

From a takeoff quantity cell, right-click and choose Recall Dimension.

When the list appears, double-click the dimension you want to fill the cell.
Printing the image

After you have digitized an image, you can print it. You also have the option of including a project name and reference information in the title block.

The project name and reference are stored for the current digitizing session only. When you exit Digitizer and Estimating, the project name and reference information are cleared.

The printed image is ‘scaled’ to make best use of the paper size of your printer (either portrait or landscape). The scale on the printed image will not match your plan scale, but is correct for the printout.

Digitize the image

Digitize the image and turn off the digitizing mode. To turn off the digitizing mode and remain in Digitizer, select the cancel button:

![Cancel]

Page Setup

To display the Page setup window, select the Page setup command on the File menu. Enter the project name and reference information you want to print in the title block on the printed image.

![Page Setup Window]

Enter the project name and reference information here. Then click OK.
Print

You can find the Print command on the File menu and the toolbar. If you have set up a project name and reference information, the title block that prints with the image looks similar to the one shown below.

To print, click here or here.

Sample Title Block

<table>
<thead>
<tr>
<th>Timberline Digitizer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project name: McKenzie Oaks 2</td>
</tr>
<tr>
<td>Reference: Landscaping</td>
</tr>
<tr>
<td>Date: Thursday, April 26, 2001 3:57 PM</td>
</tr>
</tbody>
</table>
This section includes tips to help you work more efficiently. In addition, you’ll find these and many other hints throughout the Help system.

If you want to learn more about working with Windows, choose Help on the Start menu.
Making the most of Digitizer

Digitizer provides many convenient features to help you work efficiently. In addition to the standard Windows techniques, there are others which may not be obvious at first glance.

Shortcut menus

Shortcut menus are special menus that open when you click in a window with the right mouse button (or the designated button on the pointing device). Shortcut menus provide quick access to commands related to your current task.

- In Digitizer, most of the toolbar and menu commands are available on the shortcut menu.
- In Estimating, the Digitizer, Recall Dimension, and Recall Perimeter commands are available on the shortcut menu.

Status bar

The status bar at the bottom of the Digitizer window presents helpful messages and instructions. You can also see the current drawing and count scales. A quick way to open the Scales window is to click on the Scale or Count scale field.

Totals bar

The totals bar is directly above the status bar. This is where Digitizer displays the current totals and grand total for the session. Click the totals bar to open the Current Totals window.

- This area shows the appropriate dimensions from the previous session.
- This area shows the appropriate dimensions for the current session.
Placing the toolbar conveniently

Initially, the toolbar is positioned below the graphics area. To make digitizing more efficient, you can move the toolbar around or even change its size and shape.

With the pointer on the background of the toolbar, simply drag it anywhere in the digitizer window.

- If you drop the toolbar in the graphics area, you can change its shape and size by dragging one of its borders.
- If you drop the toolbar on the window frame, it becomes attached to the frame.

Saving an image

Digitizer Extended provides a way for you to document the dimensions you digitize. The Save As/Export command (File menu) saves the image in the Digitizer window as a file which can be imported by other applications. There are options for saving the image in a .bmp (bitmap), .emf (enhanced metafile), .jpg (JPEG), or .tif (TIFF) format. You can also edit a saved image in programs such as Paint.

The Save Dimension command (File menu) includes an option to save the image of a digitized dimension as part of the estimate from which you activated the Digitizer. From Estimating, you can then edit, recall, and even import the saved dimensions into other estimates. For more about this feature, see Saving digitized results on page 28, Using the dimension list on page 38, and Importing digitized dimensions on page 39.
What to do if you make a mistake

Digitizer provides several ways for you to redo one or more digitized entities.

**Undo**

Use Undo to reverse your previous action. This button deletes the last entity that was digitized. Each click deletes one more digitized point until the current total reaches zero. In Single Line mode, Undo deletes only the last line digitized.

**Clear**

Use Clear when you want to redo a digitized object. This button clears the graphics and totals, but leaves you in the selected digitizing mode. Clear is also available on the shortcut menu.

**Cancel**

Use Cancel to start over or turn off a digitizing mode. This button deletes the image and both totals. After that, you can choose a different digitizing mode or close the digitizing session.

**Clear Graphic**

Use the Clear Graphic command when you want to delete the image from the graphics area without clearing the values in the totals bar.

To use this command, right-click and select Clear Graphic from the shortcut menu. Clear Graphic is also available on the Edit menu.

**Clear Total**

Use Clear Total when you want to reset the total to zero without losing the digitized image. This allows you to work with several images at the same time. Clear Total is also available on the Edit menu.
Digitizing from Estimating

Digitizer works hand in hand with Timberline Estimating products to make your job easier. Certain features within Estimating allow you to preset the digitizing mode, create and edit dimensions, import dimensions, and save digitized images. You can start Digitizer from any takeoff quantity cell or variable field in Estimating.

Looking for this button on the Estimating toolbar. Or right-click a takeoff quantity or variable and choose the command from the shortcut menu.

Setting the digitizing mode in advance

One convenient feature is the ability to assign a digitizing mode to the variables used by formulas in Estimating. Then whenever you start Digitizer from such a variable, it automatically starts up in the appropriate mode.
Using the dimension list

Estimating maintains a dimensions list for each estimate. This list contains not only the dimensions you save in Digitizer (see page 28), but also any dimensions you set up in Estimating. Either way, you can modify the saved dimensions as necessary before using them to determine takeoff quantities.

On the View menu, choose Edit Dimension List.

Use the toolbar buttons to:
- print a dimension,
- delete a dimension,
- add a dimension,
- or start the Digitizer.

To create a dimension, click here and enter a unique name, unit, and type.

To edit a dimension, double-click the cell and enter the new value.

To see the image for a dimension, click here.

![Image of Edit Dimension List dialog box]

![Image of Digitized dimension with dimensions 72.72]
Importing digitized dimensions

Estimating also provides a way for you to copy the digitized dimensions and images from one estimate to another estimate. There are options for replacing duplicate dimensions and for clearing the quantities and images.

To import digitized dimensions, click

Then choose the estimate containing the dimensions you want to import.
Saving digitized images for assemblies

Another feature in Estimating ensures that you always have images of the dimensions you digitize for the variable quantities in an assembly. Then when you click Done after digitizing a dimension, Digitizer saves the dimension as well as an image of that dimension with the assembly.

To use this feature, mark the Auto save Digitizer image option in the Estimating Options window (Miscellaneous tab).
Now that you’ve installed the software and been through this booklet, go ahead—and try digitizing some dimensions. It’s so easy that you can just start right in. It won’t be long before you’ll feel like an old pro.

For assistance beyond this booklet, our comprehensive Help system is always close at hand.

- While working with Digitizer, you can quickly get context-sensitive help with the [?] button or F1 key.
- If you want additional guidance, check out the information in the Help system.

**And in conclusion**

We think you’ll find Digitizer a useful tool. Thanks for taking the time to read this booklet and for becoming one of our valued users.